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Pattern Information

Getting additional information from the pattern and the model.

Measure

You may find the distance between any two points on either the pattern or the 3D model by
clicking the measure button on the tool bar. Move the cursor over the first point press down the left
mouse button, release the button over the second point. The point-to-point distance is displayed in
a dialogue in addition the coordinates of each point, the angle in the X-Y plane, the distance in the
X, Y and Z directions (delta X, delta Y, delta Z) are displayed.

First Point

True 3D distance

Distance = 195
Angle = 304.6

Paint 1:
#=0031
Y¥=-94.1
Z2=0

Coords of
each point

Second Point

Paint 2

®=5139
T ID; PRO-G7E989134, | ¥ =-254.6
| BY: B STEWART Z=0

B 0326 P

- Distance in¥ =110.8
fetance in'y = -160.5
DistanceinZ =0

Distances in the
XYZ axes

"""""""""" Cloze
imensions Enterad -
Jiameter = 300
iarmeter = 150
=1a0

Mass Properties

Information to assist estimating the cost of a project is available through the Mass Properties
feature. The shape must have been given a thickness setting and a material must have been
selected from the Properties dialog. The Materials Table must be kept up to date with current
prices for accurate cost estimates to be obtained (see Materials Editor below for instructions).

Click the material properties on the toolbar to display the Mass Properties dialogue box. This will
show us the area, mass and cost of the shape in three modes:

1. Single Rectangle Fitted Around The Entire Shape. This provides the area, perimeter,
mass and cost of material based on a rectangle fitted to the extremities of the entire shape.
The rectangle includes spacing between each item if there are multiple items. It is the
minimum rectangle from which the shape may be cut in the current position and rotation.
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2. Actual Shape. This is the true area, perimeter and mass of the cut shape. If the shape is

made up of multiple parts the area is the sum of the areas of the individual true shapes.
This will be the mass of the finished item and may also be useful during the design phase

of the project

x
i 118 |
Cancel |

Text Calor |
Change Font |

Frint |
Save |

Total Area = 0.2340015 w*2
Perimeter = 2100.33
Mass = 11.02 kg

Cost = §9.27 Dollars

Actual Shape :
Total Area = 0.1377792 m*2
Number of Items = 1
Ma=s 6.49 ko
Cost 52.56 Dollars

Material = Bisalloy 80
Thickness = 6

Material Density = 7.55 kg/m™3
Material Cost = 8.1 Dollars/kg

Single Rectangle Fitted Around Entire Shape @

Material
Description

[V Display

Important Note:

If the “Apply Label” check box is ticked,
the label information will be printed
onto the drawing. Once the label is on
the drawing, it can be moved simply by
clicking on it and holding down the left
mouse button while dragging.

Double click the label text to re-open
the label dialog box. You may change
the text color and font size. Hide the
label by de-selecting the ‘Display’
check-box.

If the material thickness is 0 (zero), then the mass and cost will also be zero.

If this is the case, exit from the Material Properties dialog and set the material thickness. The
program can now calculate the mass.

* Mass Properties

Single Rectangle Fitted Around Entire Shape @
Total Ares = 0.0749282 m*

Perimeter = 1105.71 mm
Mas= 0 kg
Cost 0 Dollars

Number of Items = 5
Hass 0 kg
Cost 0 Dollars

hetual Shape @0o————-
MNumber of Items = 5
Mass = 0 kg

Cost = 0 Dollars

Thickness = 0O
Material Density = 0 kg/m*3
Material Cost = 0 Dollars/kyg

Rectangular Shape: -—-——-
Item Airea

1 0.01z458 Jo7
a 0.0249961 87
3 0.0249961 787
4 0.0249961 787
5 0.012495 a7

Actual 3hape: —--—---—

Total Area = 0.0743882 m"

2

z

2

Material = No HMaterial 3elected

Perimeter
=]
.45
.45
.45
.88

Item Airea Perimeter
1 0.0093735 671.18
2 0.015747 793.61
3 0.018747 714.04
ks 0.015747 793,61
& 0.0093735 671.18

Multiple Rectangles Fitted Around Each Item :
Total Area = 0.0999543 m*

Hass

ooaao

g =3
Ok |
Cancel |

Text Color |
Change Font |

Fririt |
Save |

v Dizplay

If the shape consists of multiple
patterns, such as an elbow,
segmented bend or breech, additional
information is provided that details the
individual patterns.

The properties information may be
added to the pattern drawing, printed
or saved as a text file. If it is printed
or saved the Project ID, shape name,
time and date are added.
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Materials Editor

For the mass and cost to be accurate, some preliminary work is needed.

First, go to the ‘Tools’ pull-down menu and select ‘Global Options’. Click on the ‘Material’ Tab.
Click the option button to select ‘Inches’ or ‘millimeters’. Also enter the unit of currency required if
your national currency is not dollars. Click the ‘Save’ button if you wish to save these settings as

“defaults” for future shapes.

Next, click the ‘Material Editor’ button. Some
sample data has been entered into the
Materials Editor for testing purposes and
this should be replaced with current data from

The materials editor may also be
accessed directly from the ‘Tools’ pull-down

' Global Options PZ|

Calar ] General] DXF] Printing ~ Material l Save
Units Exit
@ Millimeters HE|_|D . .
© Inches your material supplier.

Currency Doollars, Pounds, Lire, etc N Ote .
M aterial E ditor
menu.

It consists of a table of ‘Description’, ‘Mass Per Unit Area’ and Cost Per Unit Area. In the case of
the metric units, the area is converted to square meters to reduce the size of the numbers. The
value “Kg/sq. m’ is the mass in kilograms of a square meter of the material per 1 mm of

thickness.

& Materials Editor

“fou may add to the list of materials. First, enter the description of the material in the blank row at the bottom of the
table. For example: Mild Steel Flate # 3 mm Thick. Delete
The kg / =q. m' iz the mass or weight of each square metre. Enter the mass as a MUMBER OMLY [do MOT
include the units]. For example, enter 23.55" not 23,55 kg'. Help
The 'Cozt / 2q. m" iz the cost of each zquare metre. Enter the cost as a MUMBER OMLY [do MOT include a
currency symbol such as $). For example, enter '8.55' not '$8.55"
D escription kg.-"sq.ﬂ Cost/kg| Remarks N
p |FVC 1.75 2.2|5ample material - data may not be comrec
ild Steel 7.85 E.E| Sample material - data may not be core:
6 Stainleszs Steel 8.3 14.3| Sample material - data may not be comec
Bisalloy 80 7.85 8.1|Sample material - data may not be corec
*

& Materials Editor,

“fou may add to the list of materials. First, enter the description of the material in the blank row at the bottom of the
table. For example: Mild Steel Plate = 178" Thick. Delete
The |b / 2q. ft' iz the mass or weight in pounds of each square foot, Enter the mass az a MUMBER OMLY [do
MOT include the unitz]. For example, enter '23.55' nat '23.55 |b" Help
The 'Cost fzq. f'" iz the cost of each square foot. Enter the cost az a HUMBER OWLY [do MOT include a
currency symbal such az $). For example, enter '8.55" not '$8.55",
Description Ibizq. fr Cost/lb| Remarks N
p |FC 1.75 2.2|Sample material - data may not be corec
tdild Steel 1.603 E.6|Sample material - data may not be corres
316 Stainleszs Steel 1.95 14.3| Sample material - data may not be corec
Bizalloy 80 1.604 8.1|5Sample material - data may not be corec
*

Material table - Metric
Some steel merchants
guote the density of material
per cubic meter (this is
typically 7850  kg/cubic
meter for steel). If this is the
case, divide it by 1000 to
get the mass per mm of
thickness. The cost is in
dollars (or your currency)
per kg.

Material table - Imperial
(inches)

In the case of the Imperial
(inch) units the area is in
square feet. The mass is
in pounds per square foot
for 1 inch of thickness of
the material. The cost is in
dollars (or your currency)
per pound (Ib).

The Materials data may also be modified using Microsoft Access, however be careful not to
change field names or leave blank rows or blank values within a row. The name of the file is

Materials.mdb
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Next, there must be a thickness setting greater than 0. With a thickness of 0 (zero), the

mass and the cost will show as 0 (zero).

Note that the materials data file, Materials.mdb, must be backed up regularly. This file will be
overwritten when you install a program update from the web-site.

i Project Identification

€ Project Identification =
r— Description LI
Shape Type:  Tranasition - Rectangle To Round - Multiple Levels ﬂl
Date: [28/01/2008 _ TestColor |
Project ID: [PRO-0123458 _ Change Fort |
Drawn By: [ STEWART Print |
Description; (ITEM # 62-345F. TRANSITIOMAL DUCTING Save |
Help |
[ Display

Click the project identification
button on the tool bar to display
the identification dialogue box.

You may enter a project identification name or number, project description and the name or initials

of the person who has produced it.

@' Plate 'n’ Sheet Professional ¥4 - [Unnamed.Pn4]

F® Fle View Tools Dimension ModFy ‘Wwindow Help

DEHSG ¢ |H@RQXT |EHE Aol sTs o9

=10j x|

x| This information will be

Text Size:

Back

Project ID
added to item
number.

NoOfLevels 3

Thess sizes are:

@ Inside " Mean  Oul
Material Thickness [ &
@8]0 lel®li]
60| 67| 67
ol 5 ) @‘ B|E k-
i Other Optigns ————————————————————————

[ Radius 0 Rectangle.

Noote: Wwhen the ‘Radius 0 aption is selscted,

the pattern is calculated using the INSIDE
limensions of the rectangle and the MEAN

diameter of the round.

28/0142008 10:39 AM
ProjectiD; PRO-123456
DrawnBy: R. STEWART
Project Description

Project ID
printed with the

ITEM # B2-345F . TRANSITIONAL DUCTING

saved with the shape
and can be recalled at
any time. It is added to
the Label and may be
printed with the
drawing. In addition, if
you have the Auto-
Dimension option “ltem
Numbers” selected the
Project ID will be
printed on each part.

[ Transition - Rectangle Ta Round - Multiple Levels
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@ Label

x
0K, |
Cancel |

Text Color |
Change Font |

Frint |
Save |

Help |

v Dizplay

r Details

Tranzition - Fectangle To Found - Multiple Levels
Full pattem
Material Thickness = B
Inzide Dimenzions Entered:-
Top Diameter = 100
Baze Length > = 300
Baze Length™ = 200
[ffzet 5 = B0
Offzet v =0
Base Radius = 25
Height = B00

Mumber of Levels =5

A label may be positioned on the drawing to
show the parameters entered to create to the
shape.

This can be printed with the pattern as a way
of identifying the pattern and so the fabricator
can check that the dimensions are correct
during the rolling or pressing operation.

Click “Display” check-box to hide or
display the label on the drawing.

If the “Display” check box is ticked, the label
information will be printed onto the drawing.

Once the label is on the drawing, it can be
moved simply by clicking on it and holding
down the left mouse button while dragging.

Double click the label text to re-open the label
dialog box. You may change the text color,
font size or hide the label by de-selecting the
“Display” check box. The label may also be
printed separately for attachment to the cut
material.

B8 Plate 'n’ Sheet Professional Version 4 - [Unnamed. pns]
[.‘" Eile “iew Tools Dimension Modify Window Help

DEE& =>? [0+

c@arf® | /HBACHBRYLOES |n -~

f—
247

‘ 300 ‘
k 1

Sizes are: @ Inside (" Mean ¢ Outside

R T eSS 5 PROJECT ID: PRO-57838313/4

DR&WH BY: R STEWART

Height = 120

Right Cone Frustum - Top Diameter and Height

1| | DATE/TIME: 8/11/2008 0257 P
@ & @ %‘ (\Z Right Cone Frustum - Top Diameter and Height
gae | g
Full pattern
RIEIE ®§ Materisl Thickness = 5 Label after
Inside Dimensions Entered - pOSitiOI’]ing on the
E sz Diameter = 300 o
Top Diameter = 150 draW|ng

740.5 Area=02 sg. m.

Do not be concerned if the label hides lines on the drawing. When it is printed the text will be
transparent. If you click the print button and view the Print Preview, you will see what the drawing

will look like after printing.
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Export DXF and Send to AutoCAD Options

Overview

The DXF is a common format for exchanging CAD data between programs. Use the ‘Export DXF’
you wish to export the unfolded pattern or 3D model to a CAD program or other software for
further drafting.

For example, you may wish to add the unfolded pattern or views Of [Pt s At s Gl
the model into an existing CAD drawing for further dimensioning.  FEEY ... Tocls Dimension Mo
Select ‘Export DXF’ and save the file with a meaningful name. Open RS

this file with the CAD program you are using and continue to work on | open.. (E));Ft)i%rr:s
It. | Close on the
These tasks are selected from the “File” pull-down menu. Save ‘File" pull-
Save As...
Export DXF...
If you are using AutoCAD (the "full* version 2000 or later) you can Send To AutoCAD...
transfer the pattern or view directly onto the AutoCAD screen.
If you are using AutoCAD LT you must save the DXF, as described RAgRSeHpi
above, and open it with AutoCAD LT. You may also insert the DXF Print
into an existing drawing as a block. Authorize...

Exit

Many NC profile cutters also use software that can read a DXF file and generate the NC code.
Nesting programs can also usually read a DXF exported from Plate ‘n’ Sheet.

The options available for the ‘Export DXF’ and ‘Send to AutoCAD’ are the same. In each case you
may export:

The Unfolded Pattern.

The 3D Model.

The current view of the 3D model as a 2D drawing.

In addition, you may choose to export the shape only or include dimensions and text.

Note that the current view determines what is exported and the options that are available. If the
current view is of the unfolded pattern, the available options will be a little different than if the view
is of the model.

In either case, when you select ‘Export DXF’, you will be prompted for a filename. Make a note of
the name and the folder. Meaningful names are usually best — use the Job Number, or client
name, etc.

Exporting a Pattern

The following options are available if the current view is of the unfolded pattern.
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The available optons are grouped

1| as follows:

® Exporting Unfolded Pattern as a DXF Cancel ‘Item s tO EXpO rt': YOU may
choose to export the cutting profile
Items to export Outzide Profile Exported as: Only, the Cuttlng proflle Wlth press
O Only the Cutting Profile- . O Arcoor Llne_Segme_nts |IneS In add|t|0n, by CIICkIng the
Export the outzide profile anly, without Expart profiles az lines and arc segments. . . .

press lines, dimensions or text. EXpOI’t A” |temS DISp|ayed
@ AutoCAD Polines checkbox any dimensions, labels

Export profiles az AutaCAD pollines.

@ Only the Cutting Profile and Presz Lines or text may be exported as part Of

Export the outside profile and press lines
orly. th e D X F .

O Export &Ml Items Displaped
Export the all items shown including D34F Tewt Size:

dimensions and test. The height of the text in drawing units.

‘Outside Profile Exported As’: These options determine the entity type used for the outside
profiles. AutoCAD polylines are a continuous sequence of connected points. It behaves as a single
entity. This has some advantages to AutoCAD users but is not always compatible with other CAD
programs.

Note: The ‘Arc and line’ option uses a series of arcs of best fit around curves. Polylines, on the
other hand, connect each point with straight-line segments. Consider increasing the number of
press lines to get a smoother curve around radii if using this option.

The DXF text size may be set at this point. The default value is determined by the Global Options
setting. This size is a dimension in drawing units. For example, if you are creating a cone that is
2400 mm in diameter, the text may have to be 50 mm high to be legible on the printed drawing.
Once the shape has been imported into a CAD program it may be modified.

Exporting a Model

The following options are available if the current view is of the unfolded pattern.

&' Export DXF... 3l The available options are
=11 grouped as follows:
® Exporting Wire-Frame Model as a DXF ‘|tems to Export’: You may
choose to export the full 3D
Iterns to export Outzide Profile Exported as: MOdeI, Whel’e eaCh pOInt iS an
O The 30 Made! ® Aic or Line Segments X,Y,Z coordinate. Alternatively,
i Export profiles & lines and t. ;
ettt Coovenats Systor e —— you may export the current view
inAutalAD. as a 2D drawing. In addition, by
@ The Current Wiew of the Madel CIiCking the ‘EXpOI‘t All Items
Export the current view as a 20 drawing. o] Dis p | ayed ) CheCkbOX any
dimensions, labels or text will be
[ Export & Items Displaped exported as pal’t Of the DXF
Expoit the allitems shown including [34F Tt Size:
dimensions and test The height of the text in drawing units.

‘Outside Profile Exported As’: These options determine the entity type used to construct the
shape. If you are exporting the 3D model you may export it as a surface mesh or as line
segments. A surface mesh can be shaded or rendered in AutoCAD but may not be compatible
with all CAD programs. A 3D model exported as lines and arcs is more compatible but is a “wire-
frame” model and cannot be shaded.
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5 Printing

Print Setup

The Print Setup dialog box is provided so that you can:

Select a printer

Set a page size

Set the page orientation (portrait or landscape mode)

Set the units to be either inches or millimeters

Decide whether the printed drawing is in color or monochrome (black and white).

= Print Setup

— | Initz

|uto HP Laserlet 2100 PCLE on RLCAD07 v |

— Orientation @ Milimeters Cancel

O Inches

. . Hel
) Paortrait — Color and Linetype =

) Landzcape &) Frint Colar
O Frint Monochiome

ad |

You will find access to the Print Setup dialog from the ‘File’ pull-down menu.. The initial (default)
settings may be set and saved in ‘Global Options’.

Print Frames

Print frames, representing the limits of your printer can be superimposed over the pattern. This
shows how the pattern is positions relative to the sheet. Sometimes rotating or moving the pattern
can save sheets of paper prior to printing.

The Two Modes of Printing

Printing a Template: Select this option if you wish to print the unfolded pattern to scale to
use as a template. The first preview will show the extents of the shape and the number of pages
required to print it.

Print the Current View: Selecting this option allows the user to print the current view
including a 3D model view or a pattern view but it will not be to scale. It will be printed at the
current zoom scale.
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— Select Print Mode

Select 'Print Template' ta if wou wizh to print the
unfolded pattern to zcale. The first presdew will
ghiow the extents of the shape and the number of
gheetz required ko print i,

O Frint Template

Select 'Print Current Yiew' o print the current
vigw, Thiz map be a 30 model views or a pattern
wigw but will nat be to zcale. 1t will be printed at
the current zoom scale,

{3 Frint Current Wiew

Tipl Select the printer and an appropriate page
zize before proceeding. Click 'Printer Setup' if pou
haven't already done 2o

¥ Cancel this dialog after printing

Continue |

i LCancel

Printer Setup |

x|

Printing the Current View

Selecting an option will
automatically display the ‘Print
Preview’ window. The preview
window will have different options
depending on whether you have
chosen to print a template or a
view.

Select “Print current view” to print what is shown on the screen. By clicking the “Display/Hide
Scale on Border” button you can choose to print showing the border and/or ruler marks. There is
only one “Select Printing Operation” option when in this mode and that is to print what displayed.

& rie
=

=

Printing a Template

e |1sle

=1

Select “Print template” if you wish to print a full-size pattern. You can choose to print the template
with or without scale marks by toggling the “Show/hide Scale on Borders” button.

If the shape is larger than the sheet size selected in ‘Printer Setup’, the outline of multiple sheets
will be superimposed over the shape. You may print individual sheets, all of the sheets or the
entire shape scaled down to fit on a single sheet. This selection is made from the drop-down list in
the upper left corner of the “Print Preview” window.
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You can print on one page or multiple pages depending on the pattern size and orientation. If

printing on multiple pages the page numbers will be shown in the bottom left hand corner (Al, A2
... B1, B2....) of the sheet.

' Print Preview - PatternExtents

Select Printing Operation Eit |

o

Ol {Scale Marks j
Select print

operation here Borders of multiple
sheets

1|
A

%

R

|l //’Z\‘

=

\/Multiple sheet j:L/

Llabels
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